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Welcome to MAGic 

MAGic® is a software solution ideally suited for computer users with low vision, 
or anyone who spends extended periods of time in front of a computer screen.  

MAGic lets you magnify your computer screen from 1 to 60 times its usual size. 
You can choose from a number of different adjustable views that let you see 
both a magnified and unmagnified portion of the screen at the same time.  

Speech features assist you in processing the information on your screen. 
MAGic can read text that you type or point at with the mouse. MAGic moves 
the magnified area of the screen so you always see the text being read and 
spotlights words as they are spoken.  

If you want to limit the amount of speaking performed by MAGic as you 
navigate windows and documents, use the Speech On Demand™ feature. It 
allows MAGic to only announce actions that are associated with a limited set of 
hot keys. Mouse echo is still available when using Speech On Demand.  

Mouse and cursor enhancements help you track the location of the mouse 
pointer and cursor on the screen. You can choose from a wide variety of 
enhancement styles. MAGic lets you change the color of these enhancements, 
apply transparency effects, adjust their size, and more.  

Color enhancements let you change how colors display on your screen. You 
can create rules that replace one color with another or switch two colors. You 
can also apply color tinting, make your screen black-and-white (monochrome), 
and invert the brightness and colors of your display. 

Other MAGic features track elements of your screen, such as the mouse 
pointer, dialog boxes, and so on. The Locator feature provides you with a way 
to quickly find and move to different areas of the screen. The MAGic multi-
directional panning system gives you complete control with adjustable speed, 
direction, stop and start, and screen navigation controls. 
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System Requirements 

The recommended minimum system requirements for MAGic are listed below.  

MAGic and MAGic Scripting Edition 

 64-bit Version: Windows® 10, Windows 8.1, Windows 7, and Windows 
Server® 2008 Release 2 

 32-bit Version: Windows 10, Windows 8.1, and Windows 7  

Processor speed  

Minimum 1.5 GHz processor  

RAM 

 4 GB recommended (64-bit) 

 2 GB recommended (32-bit) 

Required hard disk space 

 1.6 GB required during installation 

 20 MB to 690 MB required per voice for installing Vocalizer Expressive, 
Vocalizer Direct, or RealSpeak Solo Direct voices (file sizes will vary 
depending on the voice installed) 

Video 

DirectX 10 or later recommended  

Multi-monitor support  

Computer and video card that supports dual monitors; 32-bit color 
recommended; two computer monitors 

Sound  

Windows compatible sound card required (for speech). 

Note:  The Remote Access option is included when purchasing MAGic with 
scripting functionality. 
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Installing MAGic 
1. Insert the MAGic disk into your computer's disk drive.  

2. When the MAGic Setup dialog box appears, choose the MAGic Setup 
button. If you are installing Network MAGic, choose the MAGic Network 
Setup button instead.  

3. The MAGic setup program starts. You will hear the installation speak the 
instructions as they appear on your screen. Follow these instructions to 
complete the MAGic installation.  

4. Once installation is complete, you must restart your computer before 
using MAGic.  

5. Run MAGic after your computer restarts.   

The first time you run MAGic, the MAGic Startup Wizard appears. It allows you 
to configure MAGic's most commonly customized options. For example, you 
can create a hot key assignment for MAGic, configure MAGic to automatically 
run when Windows starts, play speech and sounds when Windows controls are 
selected, or install MAGic training materials. 

  MAGic Startup Wizard 

The Startup Wizard is a helpful tool containing magnification, speech, and other 
useful parameters that let you quickly configure MAGic for operation. The 
wizard is a time-saver since you do not have to search multiple menus and 
managers to customize your copy of MAGic. The Startup Wizard automatically 
runs the first time you install a new version of MAGic. The following describes 
the dialogs in the Startup Wizard. 

Note:  You must choose the Finish button in the wizard's last dialog box to 
save and activate any changes. If you cancel or escape at any point 
in the wizard, your changes will not be saved.  

Visual Settings  

Use the options in this dialog box to set magnification and display settings that 
best fit your low vision needs. 
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Default Magnification Level 

Use this edit box to set the default magnification level for MAGic. This is the 
magnification that will be used each time your start MAGic. Use the UP and 
DOWN ARROW keys to increase or decrease the magnification level. The 
default is 2x magnification. You can also choose among the following 
magnification levels: 

 1x to 2x in nine magnification increments (1.1x to 1.9x)  

 2x to 3x in three magnification increments (2.25x, 2.5x, and 2.75x)  

 3x to 4x in three magnification increments (3.25x, 3.5x, and 3.75x)  

 4x to 60x in whole number increments  

Preferred View 

Use this combo box to configure the magnified screen layout used by MAGic. 
For example: 

 Full view means that the entire screen is magnified using the 
magnification set by the Default Magnification Level option. Full view is 
the default.  

 Split view divides the screen into two halves, one magnified, one 
unmagnified.  

 Overlay view opens a magnified rectangular window positioned in the 
screen corner. As you move the mouse, that area of the screen appears 
in the magnified window.  

 Lens view opens a magnified rectangular window that follows mouse 
movement.  

 Dynamic Lens view functions like Lens View except it follows keyboard 
commands instead of mouse movement.  

Mouse Enhancement 

Select this check box to turn on mouse enhancements. These enhancements 
make it easier to track the mouse pointer and maneuver on the screen.  

Cursor Enhancement 

Select this check box to turn on cursor enhancements. These enhancements 
make it easier to follow the cursor when editing or writing text.  
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Focus Enhancement 

Select this check box to place a rectangular border around the item that is 
currently selected on the screen. This is especially helpful when trying to 
distinguish between similar screen colors. The border moves around the screen 
as you type keyboard commands or move the mouse.  

Color Enhancements 

Select this check box to use color settings and schemes for the magnified and 
unmagnified areas of the screen. This feature lets you configure MAGic to 
invert colors, set brightness, and adjust screen contrast. 

MAGic Hotkey Assignment 

Use this edit box to create your own keystroke command that will automatically 
start MAGic. You can use this shortcut instead of choosing the Desktop icon or 
the MAGic submenu. CTRL+ALT+M is the default hot key assignment.  

Startup Settings  

Use the options in this dialog box to define if and how MAGic loads when you 
start Windows. If you use the default settings, MAGic will always load and run 
before and after you launch Windows. This dialog box contains the following 
items:  

 Select the Start MAGic at the Log On screen check box so that MAGic 
loads and starts when the Windows log on screen appears. The check 
box is selected by default. If you have Standard user rights, you cannot 
change the value of this check box, and MAGic will ignore and not 
announce the check box.  

 If the Start MAGic after log on for all users check box is selected, 
MAGic loads and starts after you log on to Windows. It is cleared by 
default. If you have Standard user rights, you cannot change the value of 
this check box, and MAGic will ignore and not announce the check box.  

 The Start MAGic after log on for this user combo box lets an individual 
control if MAGic starts after he or she logs on to Windows. If Always is 
selected, MAGic starts every time the current user logs on. Always is the 
default setting. If Never is selected, MAGic will not start after the user 
logs on. If Using the All Users Setting is selected, then the following can 
happen: MAGic starts after the user logs on if the Start MAGic after log 
on for all users check box is selected, or MAGic does not start if the 
same check box is cleared.  
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 Select the Run MAGic from System Tray check box to prevent the 
MAGic button from appearing in the Windows taskbar, which is located at 
the bottom of the screen, with other programs that are currently running. 
Instead, the MAGic icon appears in the Windows system tray, which is 
located in the bottom right corner of the screen, to indicate that MAGic is 
running. Finally, when this check box is selected, the MAGic icon does 
not appear in the list of active windows when you press ALT+TAB. This 
check box is cleared by default.  

 If the Minimize on Startup check box is selected, the MAGic user 
interface is minimized when MAGic starts. To open the user interface, 
choose the MAGic button in the taskbar, or press MAGic Key+U. This 
check box is cleared by default.  

Training Materials 

This dialog box only displays when you install MAGic from the program DVD. 
The MAGic program DVD contains basic training audio files in DAISY (Digital 
Accessible Information System) format. You can use FSReader, a DAISY book 
reader from Freedom Scientific, to listen to and read the training files. To install 
the MAGic Basic Training and the What’s New DAISY books, choose Next and 
continue. The training materials are installed when you finish the wizard. 
Additional DAISY books are available for download through the FSReader 
application.  

Speech Settings 

Use the items in the Speech Settings dialog box to customize how fast MAGic 
speaks, how much punctuation is used, and whether or not typing or mouse 
echo is heard as you type or move the mouse.  

Speech Level 

Use this combo box to select full speech or Speech On Demand, which limits 
the amount of speaking by MAGic. When MAGic starts, it will use this speech 
setting.  

Rate 

Move the slider to increase or decrease how fast MAGic speaks. The 
percentage value announced via speech is relative to the current position of the 
slider bar. The value displayed in the dialog box is based on a setting within the 
synthesizer, for example, words per minute.  
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Punctuation 

Use this combo box to determine how much punctuation MAGic speaks, for 
example, some, most, all, or none.  

Enable Typing Echo  

Select this check box to turn on typing echo. Clear this check box to turn off 
typing echo.  

Typing Echo 

When typing echo is on, select one of the radio buttons to determine if MAGic 
announces characters as you type, words that you type, or both.  

Mouse Echo 

Mouse echo means that as you point at text with the mouse, MAGic will 
announce either the individual word or the entire line of text. Select one of the 
radio buttons to determine the type of mouse echo used.  

Lower the Volume of Other Programs While MAGic is 
Speaking 

When this check box is selected, the volume for all programs will be reduced 
while MAGic is speaking. This check box is cleared by default and is only 
available if MAGic is running in Windows 8.1 or later. 

Verbosity Settings 

Use the options in this dialog box to determine if MAGic speaks, plays a sound, 
or both when it encounters specific controls such as radio buttons, check 
boxes, buttons, help menus and so on. You can also configure MAGic to 
announce the state of certain controls, for example, if a check box is selected 
or not, if a button is clicked, if a dialog box closes, and so on.  

Verbosity Scheme 

Verbosity schemes give you additional control over which items MAGic 
announces, as well as how they are announced. You can also define custom 
text that MAGic speaks when you move to a control or other element on the 
screen. On the other hand, you can assign a sound that you want MAGic to 
play instead of speaking. You can also choose to combine both speech and 
sounds, or configure MAGic to ignore certain items entirely.  
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Access Key 

An underlined letter within a menu, command, or button is known as an access 
key. You can activate these items by pressing the access key in conjunction 
with the ALT key. Use the radio buttons in the Access Key group to customize 
MAGic to announce all access keys in menus and dialogs, to only announce 
access keys in menus, to only announce access keys in dialogs, or to not 
announce any access keys.  

Announce Tool Tips 

Select this check box to have MAGic announce Tool Tips of any length. A Tool 
Tip frequently appears when you rest the mouse over an item for a brief period 
of time. It gives a short description of the item. 

Announce Help Balloons 

Help balloons provide information about a selected item. When this check box 
is selected, MAGic automatically reads this information as it is displayed.  
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Standard Activation 

When you first install and start MAGic, you are asked to activate the program. 
You can use Internet License Manager (ILM) to activate MAGic using an 
Internet connection. This is the easiest and quickest way to activate your 
product. If you do not have Internet access, you can activate manually by 
telephone, fax, or by visiting www.FSActivate.com. Refer to Other Activation 
Methods for more information. 

If you do not activate at this time, MAGic runs in 40-minute mode, which 
requires a computer reboot every 40 minutes. The activation process can be 
started later by opening the Help menu and choosing Update Authorization.  

To activate MAGic using the Internet, do the following: 

1. In the Activation dialog box, choose Start Activation.  

2. Select Internet (RECOMMENDED) and choose Next.  

3. Insert the Authorization CD into your disc drive and choose Activate 
Using Authorization CD. You can find your Authorization CD in the same 
sleeve as your MAGic program disc. If you do not have your Authorization 
CD, choose Enter Your Authorization Number Manually.  

Note:  If you have previously inserted your Authorization CD, you will not 
be asked to insert it again. Continue to the next step. 

4. If you used your Authorization CD, your 20-digit Authorization number is 
automatically inserted into the Authorization Number edit box. If your 
Authorization number is not shown, type it into the edit box. You can find 
your Authorization number in print and braille on your MAGic disc sleeve.  

5. Press ENTER to continue. You will be asked to connect to the Internet if 
you have not already done so. You must establish an Internet connection 
before continuing with the activation.  

6. If you have not registered MAGic, you are asked to do so now. 
Registering MAGic lets you receive technical support. Choose Register 
Now and complete the online registration form by following the 
instructions provided. You can choose to register later, but you must 
register the next time you activate MAGic.  

7. After you submit your registration, Internet License Manager attempts to 
activate MAGic. This process may take several minutes. When the 
activation is successful, choose Finish.  
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Note:  If Internet License Manager cannot activate MAGic because of your 
firewall software, see “Troubleshooting Firewall Software” in the 
MAGic help file. 

Note: Adding or removing certain hardware components may cause your 
computer's Locking Code to change. If this occurs, you must 
reactivate MAGic. If you need to request more activations, go to 
www.FSActivate.com. 

Other Activation Methods 

To activate MAGic using a different method, do the following: 

1. In the Activation dialog box, choose Start Activation.  
2. Select Manual, by telephone, fax, or fsactivate.com, and choose Next.  
3. Select one of the following, and then follow the instructions that display in 

subsequent Activation dialog boxes:  

 Insert the Authorization CD into your disc drive and choose Activate 
Using Authorization CD, or  

 Choose Enter Your Authorization Number Manually  
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Starting and Quitting MAGic 

MAGic gives you a variety of ways to start the program:  

 Double-click the MAGic program icon on your Windows desktop  

 

 Press ALT+CTRL+M 

 Click the Start menu and choose All Programs, MAGic <version 
number>, MAGic (Windows 7 only)  

 Press WINDOWS Key+R, type "MAGic <version number>" (without the 
quotes), and press ENTER  

When you first start MAGic, your screen displays in 2x magnification using Full 
screen magnification view. Speech is also enabled (if your software is licensed 
for speech). You can then change the magnification level, magnified view, 
speech, and many other options in the MAGic user interface and Main menu.  

Starting MAGic Automatically  

The MAGic Startup Wizard appears when you first start MAGic on a Windows 
computer. If you have an Administrator account, three options appear in the 
wizard. If you have a Standard User account, only the Start MAGic after log 
on for this user combo box appears. Use the default values for these options 
if you want MAGic to start before and after Windows starts. There is no need to 
change the default values. However, if the values were changed, the following 
procedure describes how to reset the default values so that MAGic starts 
automatically.  

To set MAGic to start automatically, do the following: 

1. From the Main menu, choose File and then Preferences.  

2. Choose Automatically Start MAGic. The Start MAGic Options dialog 
box opens.  

3. Do one of the following:  
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 If three options are available, make sure that the Start MAGic at the Log 
On screen check box is selected; the Start MAGic after log on for all 
users check box is unchecked; and the Start MAGic after log on for 
this user combo box is set to Always  

 If only the Start MAGic after log on for this user combo box appears, 
make sure that it is set to Always  

4. Choose OK to accept the changes so that MAGic starts automatically when 
Windows starts.  

5. Choose OK to close the Preferences dialog box. MAGic automatically starts 
the next time you run Windows.  

Note: In Windows 8.1 or later, the “HD Smoothing Options” box displays. 
The available options determine if MAGic restarts with or without HD 
Text smoothing following a Windows or system error. For more 
information, refer to HD Smoothing Options. 
 
In Windows 7, the "Start MAGic DirectX helper after logon for all 
users" check box is selected by default. It allows MAGic to provide 
HD Text and color smoothing in some DirectX drawn applications 
including Internet Explorer. There is no need to clear this check box.  

Quitting MAGic  

To quit MAGic, do one of the following: 

 Press ALT+F4  

 Click the Close button  in the top right hand corner of the MAGic user 
interface.  

 Select Exit MAGic from the Main menu  

Tip: If you want MAGic to ask to save your settings when you quit, open 
the File menu and choose Preferences. Select the Prompt to Save 
Settings on Exit check box. 

mk:@MSITStore:C:/p4/MAGic/13.0/Documentation/ENU/MAGic%20HTML%20Help/MAGic.chm::/Getting_Started/Error_Reporting.htm#HDSmoothing
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Updating MAGic 

Freedom Scientific is continually seeking to improve and expand MAGic. 
Periodically, MAGic updates are released. It is recommended that you keep 
your software up-to-date so that you experience the greatest possible 
performance. Updates include everything from adjustments made to MAGic 
due to changes in other applications, the addition of new MAGic features, and 
fixes to issues found by users. 

Checking for Updates 

Note: When MAGic starts, it can alert you if a software update is available. 
You then have the option to install it now or later. This notification 
method is controlled using the Automatic Notification of Updates 
check box. To access the check box, choose the Main menu, 
followed by the File menu, and then Preferences. It is selected by 
default. If you turn off automatic notification, you must manually 
check for updates as described below. 

Updating your software is quick and easy. To search for updates or new 
training materials, do the following: 

1. Establish a connection to the Internet.  

2. Start MAGic.  

3. From the Main menu, choose Help, and then Check for Updates.  

4. MAGic searches the Internet for updates and displays a list of any that 
are available to download. Use the arrow keys to move through the list, 
and press the SPACEBAR to select the check box next to any updates 
that you want to download and install. You can choose the Details button 
to view more information about the currently selected update.  

Note:  If your computer has active firewall software (such as Windows 
Firewall), you may receive a warning indicating that either the 
FSAutoUpdate Application or FSAutoUpdate.exe is attempting to 
access the Internet. You must allow this process to access the 
Internet through the firewall in order to retrieve updates. If you are 
using Windows Firewall, you can do this by choosing the Unblock 
button when the warning message displays. For other firewall 
software, refer to the product's documentation. The firewall must 
allow MAGic to access the Internet using ports 20 and 21 or port 80. 
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5. When you are finished selecting updates, choose the Install button. You 
may be required to restart your computer.  

Downloading Special Updates 

Some users will be provided with a Freedom Scientific access code so that 
they can download special or private beta versions of MAGic. To search for 
these special updates, do the following: 

1. Establish a connection to the Internet.  

2. Start MAGic.  

3. From the Help menu, choose About MAGic.  

4. Choose the Special Update Code button.  

5. Type your Freedom Scientific special update code in the edit box and 
then press ENTER.  

6. From the Help menu, choose Check for Updates and follow the 
procedure described in the previous section to download and install 
updates.   
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MAGic at a Glance 

Read this topic to learn more about the MAGic user interface, its tabs and 
buttons, and basic navigation. 

MAGic User Interface 

 

(1) Main menu button   (2) Visual tab, Speech tab, and Tools tab    
(3) Title bar   (4) Focus Indicator  (5) Minimize, Close, and Help buttons    
(6) Status bar  (7) Button/Control group, for example, Visual Enhancements 

Split Buttons 

Each tab contains split buttons that allow you to quickly turn on or turn off 
MAGic functionality and quickly select basic settings. This offers the 
convenience of not having to open MAGic menus to achieve the same results. 

Use the top half of the button to turn on or off specific features.  
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Use the lower half of the button to select preconfigured schemes, or select the 
Settings option to fine-tune or create a new scheme.  

 

Focus Indicator 

The Focus Indicator consists of four corner brackets that show which item in 
the user interface has focus. When you press TAB or SHIFT+TAB to move 
through the user interface, you will see the Focus Indicator move from one item 
to the next.  
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Keyboard Navigation of the User Interface 

Use the following keystrokes to navigate the MAGic user interface and buttons. 

User Interface Keystrokes 

To perform this action … Press …  

Move from left to right through the 
entire user interface.  
 
(for example, focus moves from the 
Main menu button, to the current 
tab, through all tab items, the Help 
button, and back to the Main menu 
button) 

TAB 

Move from right to left through the 
entire user interface 

SHIFT+TAB 

Move from one tab page to the next.  
 
(for example, from Visual to Speech, 
to Tools, and back to Visual) 

CTRL+TAB (moves right)  or  
SHIFT+CTRL+TAB (moves 
left) 
 
RIGHT ARROW or 
LEFT ARROW (only 
(switches among tab pages 
when focus is on a tab) 
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Buttons and Other Controls 

Description Keystroke 

Switch the current button function on or off. Use 
this keystroke for the top half of a split button. 

SPACEBAR 

Open the list of items available for the current 
button 

ALT+DOWN 
ARROW 

Close the list of items for the current button ESC 

Increase for decrease values in a spin box, for 
example, the Magnification Level box. 

UP ARROW or  
DOWN ARROW 

Increase or decrease slider values, for example, 
the Speech Rate slider. 

RIGHT ARROW 
or  
LEFT ARROW 

MAGic Tabs 

The user interface contains the Visual tab, Speech tab, Tools tab, and Main 
Menu button. Each tab contains buttons that allow you to turn features on or 
off, select preconfigured schemes, or create your own customized schemes. 
Additional MAGic functionality is available through the Main menu as described 
later in this topic.  

Visual Tab Buttons 

With MAGic’s extensive magnification features, you can customize your display 
to fit your low vision needs. Use the items in the Visual tab to change 
magnification settings.  
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Visual Tab 
Button 

Description 

 

Turn magnification and all visual enhancements 
(mouse, color, focus, and cursor) on or off. When off, 
all enhancements in the Visual tab are unavailable. 

 

 

Switches between the current magnification level and 
1x magnification. 

 

Change the current magnification level using the 
Magnification Level box. The number in the box 
shows the current magnification level. 

 

Select your preferred view from the Magnified Views 
list. 

 

Use Mouse Enhancements to turn on or off 
enhancements and modify your mouse pointer. 
These enhancements make the mouse pointer easier 
to track and maneuver on your screen. 

 

Use Cursor Enhancements to turn on or off 
enhancements for your cursor. These enhancements 
make the cursor easier to follow when editing or 
writing text. 

 

Use Color Enhancements to turn on or off color 
enhancements. This feature allows you to replace 
colors, adjust the brightness and contrast, apply 
tinting, and invert the brightness and colors of your 
display. 
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Visual Tab 
Button 

Description 

 

Use Focus Enhancements to turn on or off the Focus 
Enhancements function. This function lets you define 
a rectangular border that makes it easier to identify 
the item that is currently selected on your screen. 

Speech Tab Buttons 

Not only does MAGic magnify your computer’s screen, but it also has screen 
reading capabilities. Use the items in the Speech tab to customize MAGic’s 
speech components to fit your needs.  

Speech Tab  Description 

 

Toggle between speech on all the time (full speech) 
or to have limited speech (Speech On Demand™). 
Refer to Choosing Speech and Speech Rate for 
more information. 

 

Move the slider left or right to adjust how fast or slow 
MAGic speaks.  

 

Use Voice Profiles to select voice settings, 
synthesizers, and languages that best fit your 
auditory preferences.  

 

Use Mouse Echo to switch the mouse echo feature 
on and off. Mouse echo enables MAGic to read text 
that you point at with the mouse.  

 

Use Typing Echo to enable or disable the typing 
echo. If typing echo is enabled, MAGic announces 
the words or characters you type 
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Tools Tab Buttons 

Use the Tools tab to access additional MAGic functionality, such as enabling 
Text Viewer, creating new keystrokes, adding items to MAGic's dictionary so 
that words, phrases, and abbreviations are pronounced correctly, and 
launching Research It, a handy tool for finding information on the Web.  

Use the items in this tab to quickly access various MAGic links and managers. 
Each item is described below.  

Tools Tab Description 

 

Use to enable or disable Text Viewer. When 
enabled, the Text Viewer window displays across the 
screen and simultaneously shows the same text that 
appears on the magnified screen. 

 

Use Links to open a list of links in the current 
document. 

 

Use Headings to open a list of headings in the 
current document. 

 

Use Skim Read to set preferences for browsing a 
document by the first sentence or line of a 
paragraph. You can also create rules to search for 
and read text containing specific words. 

 

Use Research It to easily search the Web for words, 
local weather forecast, news stories, local 
businesses, and more. 

 

Use Keyboard to assign, remove, or change hot 
keys for MAGic functions. You can also create 
shortcuts to quickly launch applications, documents, 
and Web pages.  
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Tools Tab Description 

 

Use Dictionary to change the way MAGic speaks 
words, phrases, abbreviations, or symbols.  

 

Use Script to customize MAGic for use with 
proprietary applications. This feature requires the 
scripting option.  

MAGic Menus 

The MAGic Main menu (ALT+F) is located in the upper left corner of the user 
interface. Use it to access other menus to customize and save speech, 
magnification, and keyboard settings, restore factory default settings, or access 
numerous resources on the Freedom Scientific Web site.  

You can also quickly access many of the tab and menu items using the Context 
Menu by pressing MAGic Key+MOUSE RIGHT BUTTON or MAGic 
Key+APPLICATION Key.  
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Main Menu Description 

 

The File menu allows you to save your settings 
and restore the original Freedom Scientific 
settings. You can also use this menu to change 
your MAGic preferences. 

The Visual menu allows you to customize how 
you view your screen with MAGic. You can also 
change mouse enhancements, cursor 
enhancements, color preferences, panning 
settings, view properties, and more. 

You can customize MAGic’s speech 
components to fit your particular needs. The 
Speech menu allows you to customize how you 
read text with MAGic. 

The Tools menu allows you to customize how 
you use your computer's keyboard with MAGic. 
You can re-assign the MAGic Key to a different 
key or manage shortcut keys. You can also 
access the Freedom Scientific Script Manager 
application. 

The Help menu provides you with detailed help 
information for the various MAGic functions and 
options. You can also view information on the 
newest features for this release and see your 
current MAGic version. 

 The Web Resources menu provides helpful 
links to Freedom Scientific products and 
resources such as the Freedom Scientific Web 
site, MAGic Headquarters, Technical Support 
contact page, FS Activate Web page, and other 
helpful links.  
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MAGic Hot Keys 

Note: By default, the MAGic Key is the CAPS LOCK key on your 
keyboard. Some actions in MAGic do not have hot keys assigned. 
You can define hot keys for these features using the Keyboard 
Manager. 

General 
Description General Keystrokes 

Launch MAGic 

CTRL+ALT+M (default 
keystroke – can be changed 
using the Startup Wizard) 

Run Script Manager  
(MAGic Pro Scripting Edition 
only) INSERT+0 

Display/Hide MAGic User 
Interface MAGic Key+U 

Pass Through Key MAGic Key+3 

Refresh Screen MAGic Key+ESC 

Open MAGic Context Menu 

MAGic Key+APPLICATION 
Key or  
MAGic Key+RIGHT MOUSE 
BUTTON CLICK 

Quick Settings MAGic Key+O 

Toggle Navigation Quick Keys 
On/Off MAGic Key+Z 
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Magnification, Views, and Enhancements 

Description 
Magnification, Views, and 
Enhancements Keystrokes 

Increase Magnification  

MAGic Key+NUM PAD PLUS 
or  
CTRL+EQUAL or  
MOUSE WHEEL UP (scroll 
wheel up or away from you) 

Decrease Magnification 

MAGic Key+NUM PAD MINUS 
or  
CTRL+DASH or  
MOUSE WHEEL DOWN (scroll 
wheel down or towards you) 

Magnification Toggle On/Off MAGic Key+DELETE 

Toggle between 1x 
Magnification and Current 
Magnification 

MAGic Key+SHIFT+DELETE or 
MAGic Key+MOUSE MIDDLE 
CLICK (press down on scroll 
wheel) 

Switch to Next Magnified View MAGic Key+NUM PAD SLASH 

Switch to Previous Magnified 
View 

MAGic Key+SHIFT+ 
NUM PAD SLASH 

Change Text Smoothing View 
(HD Text, Classic, and None) MAGic Key+CTRL+F 

Toggle Color Enhancements 
On/Off MAGic Key+F12 

Toggle Cursor Enhancements 
On/Off MAGic Key+F8 

Toggle Mouse Enhancements 
On/Off MAGic Key+F4 

Toggle Focus Enhancements 
On/Off MAGic Key+F 
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Panning and Screen Movement 

Description 
Panning and Screen 
Movement Keystrokes 

Pan Right MAGic Key+RIGHT ARROW 

Pan Left MAGic Key+LEFT ARROW 

Pan Down MAGic Key+DOWN ARROW 

Pan Up MAGic Key+UP ARROW 

Increase Speed during Panning NUM PAD PLUS  

Decrease Speed during 
Panning NUM PAD MINUS 

Move to Left Edge of Screen  MAGic Key+HOME 

Move to Right Edge of Screen MAGic Key+END 

Move to Top of Screen MAGic Key+PAGE UP 

Move to Bottom of Screen MAGic Key+PAGE DOWN 

Move to Beginning of Next Line MAGic Key+ENTER 

 

Tracking 

Description Tracking Keystrokes 

Tracking Toggle On/Off  MAGic Key+R 

Move View to Mouse Pointer MAGic Key+NUM PAD 5 

Move View to Cursor 
SHIFT+MAGic Key+ 
NUM PAD 5 
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Cursor Movement 

Description Cursor Movement Keystrokes 

Route Cursor to Mouse INSERT+NUM PAD PLUS 

Route Mouse to Cursor INSERT+NUM PAD MINUS 

 

Locator Mode 

Description Locator Mode Hot Keys 

Start Locator MAGic Key+F10 

Stop Locator and Move to 
Selected Area ENTER 

Stop Locator without Moving the 
Magnified Area ESC 

Move Left LEFT ARROW 

Move Right RIGHT ARROW 

Move Up UP ARROW 

Move Down DOWN ARROW 

Move to Far Left Side of Screen HOME 

Move to Far Right Side of 
Screen END 

Move to Top of Screen PAGE UP 

Move to Bottom of Screen PAGE DOWN 
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Quick View Frame 

Description Quick View Frame Hot Keys 

Toggle Quick View Frame 
On/Off MAGic Key+Q 

Set upper left corner of frame MAGic Key+LEFT BRACKET 

Set lower right corner of frame MAGic Key+RIGHT BRACKET 

Create frame around current 
dialog box option 

MAGic Key+LEFT BRACKET 
twice quickly 

Open Quick View Manager MAGic Key+9 

 

Speech 

Description Speech Hot Keys 

Silence Current Speech CTRL 

Enable/Disable Speech MAGic Key+F3 

Increase Speech Rate and Save 
New Rate 

WINDOWS Key+ALT+ 
CTRL+PAGE UP 

Increase Speech Rate - 
Temporary ALT+CTRL+PAGE UP 

Decrease Speech Rate and 
Save New Rate 

WINDOWS Key+ALT+ 
CTRL+PAGE DOWN 

Decrease Speech Rate - 
Temporary ALT+CTRL+PAGE DOWN 

Voice Profiles Toggle MAGic Key+F11 

Select Language WINDOWS Key+CTRL+L 

Set Screen Echo INSERT+S 
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Description Speech Hot Keys 

Select Verbosity Scheme INSERT+ALT+S 

 

Document and Text Reading 

Note: When using the document and text reading commands, if you move 
the mouse MAGic reads from the current location of the mouse 
pointer. If you move the insertion point, MAGic reads from the 
location of the insertion point. 

 

Description 
Document and Text Reading 
Hot Keys 

Read All from Location (Say All) 

INSERT+DOWN ARROW or 
MAGic Key+A or  
MAGic Key+LEFT MOUSE 
BUTTON CLICK  

Fast Forward During Say All RIGHT ARROW 

Rewind During Say All LEFT ARROW 

Increase and Save New Speech 
Rate During Say All PAGE UP 

Decrease and Save New 
Speech Rate During Say All PAGE DOWN 

Read Active Window (reads 
from the beginning of document 
window) 

INSERT+DOWN ARROW 
(twice) 

Say Currently Selected Text 
INSERT+SHIFT+DOWN 
ARROW 

Say Current Character NUM PAD 5 
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Description 
Document and Text Reading 
Hot Keys 

Say Current Word 
MAGic Key+ALT or 
INSERT+NUM PAD 5 

Spell Current Word 
MAGic Key+ALT (twice) or 
INSERT+NUM PAD 5 (twice) 

Say Next Word INSERT+RIGHT ARROW 

Say Prior Word INSERT+LEFT ARROW 

Select Next Word 
INSERT+SHIFT+RIGHT 
ARROW 

Select Prior Word INSERT+SHIFT+LEFT ARROW 

Say Current Line 
MAGic Key+L or  
INSERT+UP ARROW 

Say Next Line DOWN ARROW 

Say Prior Line UP ARROW 

Read to Cursor INSERT+HOME 

Read from Cursor INSERT+PAGE UP 

Say Current Sentence MAGic Key+S 

Say Next Sentence MAGic Key+CTRL+S 

Say Current Paragraph MAGic Key+P 

Say Next Paragraph 
MAGic Key+CTRL+P or  
CTRL+DOWN ARROW 

Say Prior Paragraph 
MAGic Key+ALT+P or  
CTRL+UP ARROW 

Say Contents of Clipboard MAGic Key+X 
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Description 
Document and Text Reading 
Hot Keys 

Skim Read 
INSERT+CTRL+DOWN 
ARROW 

Skim Reading Preferences 
INSERT+CTRL+SHIFT+DOWN 
ARROW 

 

Text Viewer 

Description Text Viewer Hot Keys 

Toggle Text Viewer on or off MAGic Key+CTRL+V 

Toggle Text Viewer position 
MAGic Key+CTRL+DOWN 
ARROW 

Pan Right 
MAGic Key+CTRL+RIGHT 
ARROW 

Pan Left 
MAGic Key+CTRL+LEFT 
ARROW 

Switch Text Viewer between 
monitors 

WINDOWS Key+CTRL+RIGHT 
ARROW 

 

Dialog Box Reading 

Description Dialog Box Reading Hot Keys 

Read Title Bar 
MAGic Key+T or  
INSERT+T 

Read Bottom of Window INSERT+PAGE DOWN 

Say Top Line of Window INSERT+END 
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Description Dialog Box Reading Hot Keys 

Say Default Button in Dialog 
Box INSERT+E 

Say Window Prompt and Text 
MAGic Key+TAB or  
INSERT+TAB 

Say Current Access Key SHIFT+NUM PAD 5 

 

Table Reading 

Description Table Reading Hot Keys 

Say Current Cell ALT+CTRL+NUM PAD 5 

Say Cell to Right ALT+CTRL+RIGHT ARROW 

Say Cell to Left ALT+CTRL+LEFT ARROW 

Say Cell Below ALT+CTRL+DOWN ARROW 

Say Cell Above ALT+CTRL+UP ARROW 

Say First Cell ALT+CTRL+HOME 

Say Last Cell ALT+CTRL+END 

Say First Cell in Column 
ALT+CTRL+SHIFT+UP 
ARROW 

Say Last Cell in Column 
ALT+CTRL+SHIFT+DOWN 
ARROW 

Say First Cell in Row 
ALT+CTRL+SHIFT+LEFT 
ARROW 

Say Last Cell in Row 
ALT+CTRL+SHIFT+RIGHT 
ARROW 
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Typing Echo 

Description Typing Echo Hot Keys 

Cycle through Indicate 
Capitalization options MAGic Key+F2 

Cycle through Typing Echo Unit 
options INSERT+2 

 

Mouse Echo 

Description Mouse Echo Hot Keys 

Mouse Echo Toggle MAGic Key+M 

Note: Toggling the mouse echo rotates between speak lines, speak words, 
and mouse echo off. 

 

Multi-Monitor 

Description Multi-Monitor Hot Keys 

Switch focus between monitors MAGic Key+SHIFT+D 

Restrict the mouse pointer to 
the active monitor MAGic Key+SHIFT+R 

Move the current application or 
window in focus to the monitor 
on the right or the left  

WINDOWS Key+SHIFT+RIGHT 
ARROW or  
WINDOWS Key+SHIFT+LEFT 
ARROW 

View Lock. Press and hold and 
drag mouse to move the mouse 
pointer between screens without 
scrolling any screen content. MAGic Key+SHIFT 
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Description Multi-Monitor Hot Keys 

In Overview mode, toggles 
mouse, cursor, color, and focus 
enhancements on and off on the 
unmagnified monitor. 

Press and hold MAGic 
Key+SPACEBAR, and then 
press D followed by E. 

 

Error Reporting and Recovery 

Description 
Error Reporting and Recovery 
Hot Keys 

Submit Error Report  
(Close, restart MAGic, submit 
report) INSERT+WINDOWS Key+F4 

Recover MAGic 
MAGic Key+WINDOWS 
Key+F8 
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Layered Keystrokes 

MAGic layered keystrokes offer a fast and convenient way to perform an action 
or navigate tables. These keystrokes reduce the number of keys that you need 
to hold down at once to perform an action. 

General Layer  

Press and release MAGic Key+SPACEBAR or INSERT+SPACEBAR, 
followed by a keystroke listed below to perform the action. (To exit Layer 
Keystroke mode, press ESC, SPACEBAR, TAB, or ENTER.) 
 

Description General Keystrokes 

Mute Speech S 

Launch Research It R 

Screen Capture of Entire 
Screen CTRL+C, S 

Screen Capture of Active 
Window CTRL+C, W 

Open Clipboard Text Viewer C 

 

Mouse Echo Layered Keystrokes 

Press and release MAGic Key+SPACEBAR or INSERT+SPACEBAR, 
followed by the keystrokes listed below to speak the text that you point to with 
the mouse pointer. (To exit Layer Keystroke mode, press ESC, SPACEBAR, 
TAB, or ENTER.) 
 

Description General Keystrokes 

Toggle Mouse Echo E, O 

Echo Character E, C  
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Description General Keystrokes 

Echo Word E, W  

Echo Line E, L  

Echo Paragraph  E, P  

Help Message  E, QUESTION MARK 

 

Table Layer Keystrokes 
Press and release INSERT+SPACEBAR, followed by the keystrokes below to 
navigate and read tables. (To exit Table Layer Keystroke mode, press ESC, 
SPACEBAR, TAB, or ENTER.) 
 

Description Table Reading Hot Keys 

List Keystrokes Available in this 
Layer T, SHIFT+SLASH 

Move to Cell Above 
T, UP ARROW or  
T, ALT+CTRL+UP ARROW 

Move to Cell Below 

T, DOWN ARROW or  
T, ALT+CTRL+SHIFT+RIGHT 
ARROW 

Move to Cell to Left 
T, LEFT ARROW or  
T, ALT+CTRL+LEFT ARROW  

Move to Cell to Right T, RIGHT ARROW 

Say Current Cell 

T, NUM PAD 5 or  
T, ALT+CTRL+NUM PAD 5 or  
T, ALT+COMMA 

Move to Beginning of Current 
Row 

T, HOME or  
T, ALT+CTRL+SHIFT+LEFT 
ARROW 
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Description Table Reading Hot Keys 

Move to End of Current Row 

T, END or  
T, ALT+CTRL+SHIFT+RIGHT 
ARROW 

Jump to First Cell in Table 
T, CTRL+HOME or  
T, ALT+CTRL+HOME 

Jump to Last Cell in Table 
T, CTRL+END or  
T, ALT+CTRL+END 

Move to Beginning of Current 
Column 

T, CTRL+UP ARROW or  
T, ALT+CTRL+SHIFT+UP 
ARROW 

Move to Bottom of Current 
Column 

T, CTRL+DOWN ARROW or  
T, ALT+CTRL+SHIFT+DOWN 
ARROW 

Move to Beginning of Current 
Row T, CTRL+LEFT ARROW 

Move to End of Current Row T, CTRL+RIGHT ARROW 

Jump to Next Table 
T, CTRL+ENTER or  
T, ALT+CTRL+ENTER 

Jump to Prior Table 
T, CTRL+SHIFT+ENTER or  
T, ALT+CTRL+SHIFT+ENTER 

Read the Current Row 
T, SHIFT+UP ARROW or  
T, WINDOWS Key+COMMA 

Read from Current Cell T, SHIFT+PAGE UP 

Read to Current Cell T, SHIFT+HOME 
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Description Table Reading Hot Keys 

Read Current Column 
T, SHIFT+NUM PAD 5 or  
T, WINDOWS Key+PERIOD 

Read to Bottom of Column T, SHIFT+PAGE DOWN 

Read from Top of Column T, SHIFT+END  

Jump to Previous Cell  

T, WINDOWS Key+J or  
T, CTRL+SHIFT+WINDOWS 
Key+J 
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Windows Shortcut Keys 

General 

Description General Shortcut Keys 

Get Help F1 

Open the Start menu 
WINDOWS Key or  
CTRL+ESC 

Open Windows Explorer WINDOWS Key+E 

Open the Run dialog box WINDOWS Key+R 

Find file or folder from Desktop F3 

Minimize all windows WINDOWS Key+M 

Switch between programs ALT+TAB 

Quit the active program ALT+F4 

 

For Windows and Menus 

Description 
Windows and Menus Shortcut 
Keys 

Open the application control 
menu ALT+SPACEBAR 

Move to the menu bar ALT 

Choose a menu command ENTER 

Move between menus ALT, arrow keys 

Close a menu ESC 

Close a cascading menu ALT 
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Description 
Windows and Menus Shortcut 
Keys 

Open a child window control 
menu ALT+HYPHEN 

Close a child window CTRL+F4 

Open the context menu 
APPLICATION Key or  
SHIFT+F10 

 

For Dialog Boxes 

Description Dialog Boxes Shortcut Keys 

Move through dialog box 
options TAB 

Move backward through dialog 
box options SHIFT+TAB 

Move to another tab CTRL+TAB 

Reverse direction through tabs CTRL+SHIFT+TAB 

Move to first option HOME 

Move to last option END 

Select or clear an item in a list 
SPACEBAR or  
CTRL+SPACEBAR 

Select or clear a check box SPACEBAR 
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For Reading Text 

Description Reading Text Shortcut Keys 

Move left one character LEFT ARROW 

Move right one character RIGHT ARROW 

Move left one word  CTRL+LEFT ARROW 

Move right one word  CTRL+RIGHT ARROW 

Move to beginning of line HOME 

Move to end of line END 

Move up one paragraph CTRL+UP ARROW 

Move down one paragraph CTRL+DOWN ARROW 

Scroll up one screen PAGE UP 

Scroll down one screen PAGE DOWN 

Move to beginning of document CTRL+HOME 

Move to end of document CTRL+END 

 

For Editing Text 

Description Editing Text Shortcut Keys 

Copy CTRL+C 

Cut CTRL+X 

Paste CTRL+V 

Undo CTRL+Z 

Delete character to the left BACKSPACE 
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Description Editing Text Shortcut Keys 

Delete character to the right DELETE 

Select one character left SHIFT+LEFT ARROW 

Select one character right SHIFT+RIGHT ARROW 

Select one word left CTRL+SHIFT+LEFT ARROW 

Select one word right CTRL+SHIFT+RIGHT ARROW 

Select to beginning of line SHIFT+HOME 

Select to end of line SHIFT+END 

Select to beginning of document CTRL+SHIFT+HOME 

Select to end of document CTRL+SHIFT+END 

Select all CTRL+A 

 

For Windows Explorer 

Description 
Windows Explorer Shortcut 
Keys 

Rename selected file or folder F2 

Open properties ALT+ENTER 

Refresh a window F5 

Switch between panes 
F6 or  
TAB 

Go up a level BACKSPACE 

 


